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Part I.   Install Software 
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บทที่ 1 
Install Software 

 
Install Software EasyMatchQC 
 
 ใสแผน CD โปรแกรม EasyMatch QC. ที่ Drive CD-ROM โปรแกรมจะทํางานแบบ AutoRun 
เพื่อจะเขาสูการลงโปรแกรม (ถาไมทํางานแบบAutoRun  ใหเรียกโปรแกรม EasyMatchQC-Setup จาก
แผน CD มาทํางาน) 

 
 
 
 
 
 
 
 
 
 
โปรแกรมเริ่มทํางาน 
 
 
 
 
 
 
 
 
 
 
กดปุม Next เพื่อดําเนินการตอ 
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เลือก Complete กด Next  
 
 
 
 
 
 
 
 

 
ใสช่ือ User และ Company 
 
 
 
 
 
 
 
 
 

 
 

                   เลือกการยอมรับเงื่อนไข Software แลวกด Next 
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            กด Next แลวดําเนินการตอ 
 
 
 
 
 
 
 
 
 
 
รอใหโปรแกรมดําเนินการ 
 
 
 
 
 
 
 
 

 
 
รอใหโปรแกรมดําเนินการ 
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      กด Finsh โปรแกรมจะดาํเนินการตอ 

 
 
 
 
 
 
 
 
 
 

         โปรแกรมจะทําการลง Driver ของ Hardlock กด Finish 
 
 
 
 
 
 
 

 
 
กด Finish ( ลงโปรแกรมเสร็จสิ้น) 
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  การเรียกใชโปรแกรม EasyMatch QC มาทํางาน   ให Double-Click ที่ ICON EasyMatchQC                
โปรแกรมจะทาํงานและเขาหนาจอ ตามรูป  

 
 
 
 
 
 
 
 
 
 
 
 

      กด OK.  
 
 
 
 
 
 
 
 
 
 
 
 
รูปแบบของโปรแกรม 

  
หลังจากนัน้   ตองทําการกําหนดใหโปรแกรมรูจักกับเครื่องวัดสี  โดยเขาที่ Menu Sensors เลือก 

Install/Configureทําการกําหนดตัวเครื่องวดัสีใหตรงรุน , Set Port ใหตรงกับการตอเขากับคอมพิวเตอร  
ทําการ Standardize แลวสราง File job กอนเริ่มตนการวดั 
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รูปแบบกอนการวัดตัวอยาง 
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เร่ิมตนใชงาน 
เร่ิมตนใชงาน/Set Sensor 
หมายถึง การตัง้คาของเครื่องวัดสีกอนการใชงาน ( Set คร้ังแรกครั้งเดยีว) 

1. ทําการเปดเครือ่งวัดสีใหเรียบรอย 
2. Double Click ที่ Icon EasyMatch QC 
3. จะเขาหนาจอของโปรแกรม EasyMatch QC 
4. เขา Menu Sensor เลือก Install/Configure 
5. เลือก Add Sensor 

 
 
 
 
 
 
6. เขาที่ Sensor Type เลือกรุนของเครื่องวัดสี ,เลือก Sensor ID ,เลือก Comunication Port ,เลือก 

Buad Rate ตัวอยาง ในสวน Sensor เลือก ColorFlex , Sensor ID กาเครือ่งหมายถูก, 
Comunication Port Com1, Baud Rate 9600 

 
 
 
 
 
 

 
7. กด Next 
8. หนาจอจะขึ้น Mode สําหรับการวัด 
9. กด Finish 

 
 
 
 

 



   Color Global Co.,Ltd.  

10

 
10. โปรแกรมจะทาํการ Standardize เครื่อง โดยจะทําการอานคา Black Glass กอน 
 
 
 
 
 
 
 
 
 ใหวางแผน Black Glass ปด Port เพื่อทําการวัด  
11. โปรแกรมจะทาํการอานคา White Tile 

 
 
 
 
 
 
 
 
  ใหวางแผน White Tile ปด Port เพื่อทําการวัด 

12. เมื่อทํา Standardize เรียบรอยเคร่ืองก็พรอมสําหรับการใชงาน 
 
 
 
 
 
 
 
 
  กด Finish 
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13. โปรแกรมจะทาํการแจงขอมลูของตัวเครื่องวัดสีใหทราบ 
 
 
 
 
 
 
 
 
 
 กด OK. 
 
14. โปรแกรมก็พรอมสําหรับทําการวัดได 
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เร่ิมตนใชงาน/การใชงานโปรแกรม 
 
 

1. เปดเครื่องวัดสี HunterLab 
2. เขาโปรแกรม EasyMatch QC 
3. ทําการ Standardize เคร่ืองโดย 

3.1 เลือก Icon Standardize                         หรือ 
3.2 เขา Menu Sensor เลือก Standardize หรือ 
3.3 เขา  Menu Sensor เลือก Set Mode เลือก Mode ท่ีจะทําการวัด แลว เลือก Standardize 

4. ทําการ Standardize เคร่ือง 
5. ทําการตรวจสอบการทํางานของเครื่องโดยทําการวัดคา White Tile เทียบกับคาท่ีมาจาก 

HunterLab 
6. ทําการสรางที่เก็บขอมูล (สราง Job หรือ Open Job ) 
7. เร่ิมตนทําการวัดคา 
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Part II.   Software Overview 
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บทที่ 2  
   Introduction to EasyMatch QC 

 

Jobs 
หมายถึง ช่ือของงานที่เราจะจัดเก็บ ทั้งในสวนของคาStandard และ คาSamples  

 
 
 
 
 
 
 
 
 
 
 

Templates 

หมายถึง โครงสรางหรือลักษณะของการจัดแตงรูปแบบของโปรแกรม เราสามารถเลือกจัดรูปแบบของ
โปรแกรมตามที่เราตองการและจัดเก็บไวได 
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Data Views 
หมายถึง หนาจอตางๆที่ใชในการทํางานของโปรแกรม ซ่ึงมีอยูดวยกนัทั้งหมด 8 รูปแบบและเราสามารถ
เลือกการจัดตําแหนงการจัดวางตามรูปแบบที่ตองการได 

  
รูปแบบของ Data Viewsมีดังนี้ 

- Job Tree 
- Color Data Table 
- Color Plot 
- Color Render 
- EZ View 
- Spectral Data Table 
- Spectral Plot 
- Trend Plot 

 
1. Job Tree 

เปนรูปแบบของหนาจอที่จะโชวช่ือของขอมูลที่อยูใน Job ทั้งในสวนของคา Standard และ คา 
Samples โดยจะแสดงเปนรูปแบบของชื่อ ในลักษณะของโครงสรางตนไม 

 
 
 
 
 
 
 
 
 
 
 
เราสามารถ Click ที่เครื่องหมาย + เพื่อเขาไปดูสวนยอย หรือ Click ที่เครื่องหมาย – เพื่อ
ยอนกลับไปหรือลดรูปได  สามารถเลือกขอมูลพรอมใชรวมกับปุม Ctrl เพื่อเลือกขอมูลทีละคา 
หรือใชรวมกบัปุม Shift เพื่อเลือกคาเปนชวงๆได 
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ในสวนของขอมูลเราสามารถใชคําส่ังรวมไดดังนี ้

- Cut คือ การตัดเอาขอมูลสวนนี้ไปใสไวในสานอื่น ใชรวมกับคําส่ัง Paste 
- Copy คือการสั่งคัดลอกขอมูลสวนนี้ไปใสไวในสวนอืน่ ใชรวมกับคําส่ังPaste 
- Paste คือ การสั่งใหขอมูลที่ไดจากการ Cut หรือ Copy วางในสวนทีต่องการ 
- Delete คือ การลบขอมูลสวนนี้ออก 
- Properties คือ การดูรายละเอยีดของขอมูล ถาขอมูลเปน Standard สามารถดูรายละเอยีด

ของขอมูลในสวนของ Tolerances ได 

 
 
 
 

 
 
 
  
 
 
 

 
 

และ สามารถสรางคาในสวนของ Hitch ได 
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- Show This Item Only คือ การโชวขอมูลเฉพาะสวน ( Standard และ Samples ที่
เกี่ยวของกัน)  ถาตองการโชวขอมูลทั้งหมด ใหเปลีย่นกลับมาเลือกเปน Show All Item 

- Copy Sample To Standard คือ การสามารถยายขอมูลในสวนของSample มาเปนคา
Standard  โดยจะทําการทับคาของ Standard ตัวเดิม 

- Copy Sample To New Standard คือ การสามารถยายขอมูลในสวนของ Sample มาทํา
เปนคาของ Standard ตัวใหมได 

- Copy Standard To Sample คือ การยายขอมูลในสวนของ Standard มาทาํเปนคาของ 
Sample 

 

เมื่อใช Mouse Click ปุมขวาในกรอบของ Job Tree  จะมีคําสั่งที่ใชงานอีกสวน
หนึ่ง 
- Print Preview คือ การตรวจดรููปแบบกอนการสั่งพิมพงาน ในสวนของ Job Tree  

 
 
 
 
 
 
 
 
 

 
- Print this view คือ การสั่งพิมพในสวนของ Job Tree  
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- Show All Item คือ การสั่งใหโชวขอมูลที่อยูในสวนของ Job Tree ทั้งหมด  
 
- Enter Standard Data คือ การตั้งคาของ Standard เองโดยการปองคาของขอมูลเอง 

(ขอมูลไมไดเกิดจากการวดั) 

 
 
 
 
 
 
 
 
 
 
 
 

- Enter Sample Data คือ การตั้งคาของ Sample เองโดยการปอนคาของขอมูลเอง (ขอมูล
ไมไดเกิดจากการวัด) 
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- Collapse the tree คือ การสั่งใหปดรูปแบบของโครงสรางตนไม 
 
- Maximize this View คือ การสั่งใหแสดงหนาจอของ Job Tree เต็มหนาของโปรแกรม 

- Restore View คือ การสั่งใหหนาจอที่ขยายเต็มโปรแกรมกลับสูรูปแบบเดิม 
 

2. Color Data Table 
คือ รูปแบบของหนาจอที่โชวขอมูลในสวนของ Color Scale, Color Difference และ Index Data 
ในสวนของคา Standard และ คา Sample 

 
 
 
 
 
 
 

 
 
 
ถา Click ขวาที่หนาของ Color Data Table จะมี Option ดังนี ้

- Copy to Clipboard คือ การคัดลอกขอมูลไปใชรวมกับโปรแกรมอื่นๆ  การใชงานตอง
ทําการมารคขอมูลในสวนทีจ่ะคัดลอกกอนแลวคอยเลือกการทํางานของคําส่ังนี้ 

- Configure คือ การโชวขอมูลตางๆในหนาจอของ Color Data Table 
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โดยในสวนของ Scale, Illuninant/Observer, Difference และ Indices ใชการHightlight 
เพื่อเลือก  สวนAdditional Information ใชกาเครื่องหมายถูกเพื่อเลือกใชงาน 
ในสวนของ Color Data Table Configure มีตัวชวยใหสามารถสรางField หรือกําหนด
สูตรในการใชงานไดเองโดยสามารถทําการกําหนดได  2 Field หรือ 2 สูตรแลวแตการ
เลือกใชงาน โดยตองเรียกใชงาน Insert Custom Field 
 
รูปแบบการใชงาน 
Custom Data Field 

 Click Insert Custom Field จะเขาสวนของ Configure 
 
 
 
 
 
 
 ในสวนของ Data Field ใหเลือก New และในสวน Label ใหใสช่ือ 

Field ที่ตองการ ตัวอยาง ในสวนของ Label ใหใสช่ือ “ Oven 
Temperature “ 

 
 
 
 
 
 
 Click OK แลวเลือก Click OK อีกครั้งจาก Color Data Table 
โปรแกรมจะโชว Field ในสวนที่ไดสรางขึ้นมาใหม 
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 ใช Mouse Click ขวาในชองวางของ Field ที่เราสรางเพื่อที่จะไดกรอก
ขอมูล ใหทําการกรอกขอมูล (ตัวเลข) แลวกด OK. 

 
 
 
 
 

 
 
 
 
 
 

Custom Formula Field 
 Click Insert Data Field จะเขาหนาจอ Configure 

  
 
 
 
 
 

 Click ในสวนของ Formula Field และในสวนของ Label ใหใสช่ือ 
Label ที่ตองการจากตัวอยางใสช่ือ “ ABC Index “ 

 
 
 
 
 
 

 Click OK. จะเขาหนาจอของ Configure Formula Field 
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 ในสวนของ Formula เปนชองสําหรับให Key สูตรที่ตองการ โดย
จะตองมีเครื่องหมาย “ = “ อยูหนาสูตรทีจ่ะใส 

 รูปแบบของสูตร และการใชงาน 
รูปแบบของ Field จะโชวทั้ง Column และ Row โดย Column จะใช

การแสดงเปน A-Z (จากซายไปขวา) สวน Row จะใชการแสดงเปน 1 to n ( 
จากบนลงลาง) เชน Cell ซายสุดของ Column คือ A1 แตการจะนาํ Cell ทั้ง 
Column ไปใชในสูตรตองใหสูตรรูกอนวานี่คือสวนของCell ทั้ง Column 
จึงจําเปนตองกําหนดสัญลักษณเพื่อบอก โดยตองใสเครือ่งหมาย “ # “ 
ตอทายคา Cell ทั้ง Column เชน ถาตองการใช Cell ทั้ง Column C ใหใสใน
สูตรวา C# เปนตน 
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    สัญลักษณในการใชสูตร 
    +  Addition 
    -  Subtraction 
    ^  Power operator 
    *  Multiplication 
    /  Division 
    &  Logical And 
    |  Logical Or 
    !  Negation 
    >  Greater than 
    <  Less than 
    =  Equality 
    :  Sum a range of cells. 
     
    Functions ในการนําสูตรไปใชงาน 
   ABS(Coord)   Returns the absolute value of the cell. 
   ADD(a, b)   Adds the two element. 
   IF( a, b, c )   If a is true, cellis assigned b, else assigned 
c. 
   ISEMPTY(Coord)  Returns TRUE if the cell is empty, FALSE 
otherwise. 
   NEG(Coord)   Retures the negative of the value in the cell. 
   NOT(Coord)   Returns te logical NOT of the cell’s value. 
   PMT(Amt, Interest, Term,   
       TermsPerYear )  Returns te payment given the specified loan 
information. 
   ROUNDUP(Value, Precision) Returns the value of the cell rounded up the 
next integer. 

ROUND(Value, precision) Returns the value of the cell rounded up ( if 
0.5 or greater) or down.  

TRUNCATE(Value, precision) Returns the value of the cell truncated at the 
given precision. 
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ตัวอยางการใชสูตร  
A1:A10 Sums the first column , rows 1 throung 10. 
3.1415*C6 Pi times the value in C6. 
 
 
 
A#*G# The cell in column A, this row, multiplied 

by the value of the cell at column G, same 
row. 

(A1+B1)*C1 Adds the first two cells and multiplies the 
result by the thired. 

IF(A1>5, A1*2,A1*3) If the contents of A1 are greater than 5, than 
multiply A1 by 2, else multiply A1 by 3. 

 
 Click Set Formula แลว Click OK. แลว Click OK. จาก Color Data 

Table โปรแกรมจะโชวคา Field และคาที่ไดจากการคํานวณของสูตรที่
ไดสรางไว 

 
 
 
 
 
 

 
 

- Print Preview คือ การตรวจดรููปแบบกอนการสั่งพิมพงาน ในสวนของ Color Data 
Table 

- Print this View คือ การสั่งพิมพขอมูลของ Color Data Table 
- Change View คือ การเปลี่ยนหนาจอที่ทํางานอยูเปนหนาจอของ Data View ที่ตองการ 
- Delete View คือ การลบหนาจอที่ทํางานอยู 
- Split View Vertically and Add คือ การเพิ่มหนาจอของ Data View ออกทางดานขาง

ของหนาจอเดมิ 
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- Split View Horizontally and Add คือ การเพิ่มหนาจอของ Data View ออกทางดานลาง

ของหนาจอเดมิ 
- Maximize this View คือ การสั่งใหแสดงหนาจอของ Color Data Table โชวเต็มหนา

ของโปรแกรม 
- Restore View คือ การสั่งใหหนาจอที่ขยายเต็มโปรแกรมกลับสูรูปแบบเดิม 

 

3. Color Plot 
คือหนาจอที่โชวรูปแบบเปนกราฟ  โดยโชวรูปแบบในสวนของคา Sample เทียบกบัคาของ 
Standard โดยจะแสดงในแบบ Scale L*a*b* โดยคา a* จะอยูในแนวแกน X , คา b* จะอยูใน
แนวแกน Y สวนคา L* จะอยูในแนวแกนตั้งแยกตางหากจาก a* และ b*  ความหมาย ใน
แนวแกน X และ แกน Y จุดตัดกันคือสวนของคา Standard จุดที่ Plot ลงบนกราฟคือสวนของคา 
Sample แตละ 
 
ตัวที่เปรียบเทยีบกับคาของ Standard   ในแนวแกนของคา L* ตรงกลางคือคาของ Standard จุดที่ 
Plot ลงคือคาของ Sample เทียบกับ Standard 

 
 
 
 
 
 
 
 

 
     ปุม Scroll ดานซายคือ การ Zoom เขา Zoom ออกของแนวแกน X , Y (a*, b*) 
     ปุม Scroll ดานขวาคือ การ Zoom เขา Zoom ออกของคา L* 
เมื่อ Click ขวาที่กรอบของ Color Plot จะมี Option ใหใชดังนี ้

- Show Background คือ การสั่งใหโชวรูปแบบของ Scale สีดานหลังของกราฟ 
- Show Legend คือ การสั่งใหโชววามีขอมูลอะไรอยูใน Color Plot บาง 
- Configure คือ การเลือกรูปแบบของ Color Plot 
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   ในสวนของ Display Mode ถาเลือก Absolute มันจะโชววาตวัอยางมแีนวสีอยูทางสวน
ไหน  แตถาเลือก Relative มันจะโชวตัวอยางเทียบกับคา Standard วาตางกับตัวอยางไปใน
แนวทางสีไหน 
- Print Preview คือ การตรวจดรููปแบบกอนการสั่งพิมพงาน ในสวนของ Color Plot 

 
 
 
 
 
 
 
 
 
 
 

- Print this View คือ การสั่งพิมพขอมูลของ Color Plot 
- Change View คือ การเปลี่ยนหนาจอที่ทํางานอยูเปนหนาจอของ Data View ที่ตองการ 
- Delete View คือ การลบหนาจอที่ทํางานอยู 
- Split View Vertically and Add คือ การเพิ่มหนาจอของ Data View ออกทางดานขาง

ของหนาจอเดมิ 
- Split View Horizontally and Add คือ การเพิ่มหนาจอของ Data View ออกทางดานลาง

ของหนาจอเดมิ 
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- Maximize this View คือ การสั่งใหแสดงหนาจอของ Color Plot โชวเต็มหนาของ

โปรแกรม 
- Restore View คือ การสั่งใหหนาจอที่ขยายเต็มโปรแกรมกลับสูรูปแบบเดิม 

 

4. Color Render 
คือ หนาจอที่โชวรูปแบบของสีที่ไดจากการวัด 

 
 
 
 
 
 
 
 
 
 

Standard 

Sample 

 
เมื่อ Click ที่กรอบของ Color Render จะมี Option ดังนี ้

- Configure คือ การ Set รูปแบบของ Illuminant และ Observer สามารถโชวพรอมกันใน
สวนของ Standard ได 3 แบบ 
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- Print Preview คือ การตรวจดรููปแบบกอนการสั่งพิมพงาน ในสวนของ Color Render 

 

 
 
 
 
 
 
 
 
 
 
 

- Print this View คือ การสั่งพิมพขอมูลของ Color Reder 
- Change View คือ การเปลี่ยนหนาจอที่ทํางานอยูเปนหนาจอของ Data View ที่ตองการ 
- Delete View คือ การลบหนาจอที่ทํางานอยู 

 
 

- Split View Vertically and Add คือ การเพิ่มหนาจอของ Data View ออกทางดานขาง
ของหนาจอเดมิ 

- Split View Horizontally and Add คือ การเพิ่มหนาจอของ Data View ออกทางดานลาง
ของหนาจอเดมิ 

- Maximize this View คือ การสั่งใหแสดงหนาจอของ Color Render โชวเต็มหนาของ
โปรแกรม 

- Restore View คือ การสั่งใหหนาจอที่ขยายเต็มโปรแกรมกลับสูรูปแบบเดิม 
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5. EZ View 

คือ การโชวรูปแบบของขอมูลอยางงาย 

 
 
 
 
 
 
 
 
 
 

 
 
 
 

เมื่อ Click ที่กรอบของ EZ View จะมี Option ดังนี ้
- Configure คือ การเลือกขอมูลที่จะโชว 
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- Print Preview คือ การตรวจดรููปแบบกอนการสั่งพิมพงาน ในสวนของ EZ View 

 
 
 
 
 
 
 
 
 
 
 

- Print this View คือ การสั่งพิมพขอมูลของ EZ View 
- Change View คือ การเปลี่ยนหนาจอที่ทํางานอยูเปนหนาจอของ Data View ที่ตองการ 
- Delete View คือ การลบหนาจอที่ทํางานอยู 

 
 

- Split View Vertically and Add คือ การเพิ่มหนาจอของ Data View ออกทางดานขาง
ของหนาจอเดมิ 

- Split View Horizontally and Add คือ การเพิ่มหนาจอของ Data View ออกทางดานลาง
ของหนาจอเดมิ 

- Maximize this View คือ การสั่งใหแสดงหนาจอของ Color Plot โชวเต็มหนาของ
โปรแกรม 

- Restore View คือ การสั่งใหหนาจอที่ขยายเต็มโปรแกรมกลับสูรูปแบบเดิม 
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6. Spectral Data Table 

คือ หนาจอที่โชวขอมูล %Reflectance, %Transmission, K/S หรือคาAbsorbance โดยโชวขอมูล
ในรูปแบบของ Wavelengths (nm) 

 
 
 
 
 
 
 
 
 
 

 
เมื่อ Click ขวาจะม ีOption ใหใชงานดังนี ้

- Copy to Clipboard  กอนใชงานตองทําการ Mark หรือ Highlight ขอมูลเพื่อทําการเลือก
กอน แลวคอยใช Optionนี้ เพื่อนําเอาขอมลูไปใชรวมกบัโปรแกรมอื่นเชน EXCEL โดย
ใชรวมกับคําส่ัง  Paste 

- Paste from Clipboard  คือการนําเอาขอมูลจากโปรแกรมอื่นนํามาใสในหนาจอนี้ โดย
จะตองมีการวางตําแหนงของ Cell เหมือนกัน 

- Configure หมายถึง การSet การทํางาน และการโชวขอมลูของหนาจอ Spectral Data 
Table 
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- Print Preview คือ การตรวจดรููปแบบกอนการสั่งพิมพงาน ในสวนของ Spectral Data 

Table 

 
 
 
 
 
 
 
 
 
 
 
 

- Print this View คือ การสั่งพิมพขอมูลของ Spectral Data Table 
- Change View คือ การเปลี่ยนหนาจอที่ทํางานอยูเปนหนาจอของ Data View ที่ตองการ 
- Delete View คือ การลบหนาจอที่ทํางานอยู 
- Split View Vertically and Add คือ การเพิ่มหนาจอของ Data View ออกทางดานขาง

ของหนาจอเดมิ 
- Split View Horizontally and Add คือ การเพิ่มหนาจอของ Data View ออกทางดานลาง

ของหนาจอเดมิ 
- Maximize this View คือ การสั่งใหแสดงหนาจอของ Spectral Data Table โชวเต็มหนา

ของโปรแกรม 
- Restore View คือ การสั่งใหหนาจอที่ขยายเต็มโปรแกรมกลับสูรูปแบบเดิม 
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7. Spectral Plot 
คือ หนาจอที่ใชสําหรับโชวขอมูลในรูปแบบของกราฟเสน โดยคาในแนวตั้งหมายถึง % 
Reflectance, %Transmittance, K/S หรือคา Absorbance สวนคาในแนวนอนหมายถงึคาความถี่
ของคลื่นแสดงคาเปน Wavelength (nm) 

 
 
 
 
 
 
 
 
 
 
 
เมื่อ Click ขวาจะมีหนาจอของ Option ใหใชดังนี ้

- Show Background คือ เมื่อเลือกจะโชวคา สีBackground (สีรุง)ตามตําแหนงของ 
Wavelength(nm) 

- Show Legend คือ การโชวคาของขอมูล Standard และ Sample ที่ Plot อยูบนกราฟ 
- Configure คือ การกําหนดรูปแบบของการโชวขอมูลของหนาจอ Spectral Plot 

 
 
 

 
 
 
 

โดยเลือก Parameter ที่จะใชงาน  เลือก Wavelength และPercent ranges ที่จะด ู
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- Print Preview คือ การตรวจดรููปแบบกอนการสั่งพิมพงาน ในสวนของ Spectral Plot 

 
 
 
 
 
 
 
 
 
 
 
 
 

- Print this View คือ การสั่งพิมพขอมูลของ Spectral Plot 
- Change View คือ การเปลี่ยนหนาจอที่ทํางานอยูเปนหนาจอของ Data View ที่ตองการ 
- Delete View คือ การลบหนาจอที่ทํางานอยู 
- Split View Vertically and Add คือ การเพิ่มหนาจอของ Data View ออกทางดานขาง

ของหนาจอเดมิ 
- Split View Horizontally and Add คือ การเพิ่มหนาจอของ Data View ออกทางดานลาง

ของหนาจอเดมิ 
- Maximize this View คือ การสั่งใหแสดงหนาจอของ Spectral Plot โชวเต็มหนาของ

โปรแกรม 
- Restore View คือ การสั่งใหหนาจอที่ขยายเต็มโปรแกรมกลับสูรูปแบบเดิม 
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8. Trand Plot 

คือ หนาจอที่แสดงขอมูล เปนเสนกราฟแบบกราฟแทง โดยอาศัยความแตกตางของคา Standard 
และคาSample โดยดูคาความตางของ Sample วาตางกับคาของ Standard ออกไปในแนวทางไหน 

 
 
 
 
 
 
 
 
 

 
 
เชน ถา Sample ดํากวา Standard กราฟแทงจะโชวสีดําในสวนของ Scale L* 
       ถา Sample แดงกวา Standard กราฟแทงจะโชวสีแดงดานบนในสวนของ  a* 
       ถา Sample น้ําเงินกวา Standard กราฟแทงจะโชวสีน้ําเงินในสวนของ b* 
เมื่อ Clickขวาในกรอบของ Trand Plot จะมี Option ใหใชดังนี ้

- Configure คือ การเลือกรูปแบบในการโชวขอมูลของหนาจอ Trand Plot 

 
 
 
 
 
 
 

 
เราสามารถเลือก Parameter ใชงานเชน Color Scale, การเลือกคาของตําแหนงทั้ง 4 แถว, 
เลือกแหลงแสงและมุมที่จะดู, การเลือกดกูราฟแบบ Line หรือ Point 

 

 



   Color Global Co.,Ltd.  

36

 
- Limits คือ การกําหนดคาของตําแหนงของแถวทั้ง 4 แถว 

 
 
 
 
 
 
 

 
- Print Preview คือ การตรวจดรููปแบบกอนการสั่งพิมพงาน ในสวนของ Trand Plot 

 
 
 
 
 
 
 
 
 
 
 
 

- Print this View คือ การสั่งพิมพขอมูลของ Trand Plot 
- Change View คือ การเปลี่ยนหนาจอที่ทํางานอยูเปนหนาจอของ Data View ที่ตองการ 
- Delete View คือ การลบหนาจอที่ทํางานอยู 
- Split View Vertically and Add คือ การเพิ่มหนาจอของ Data View ออกทางดานขาง

ของหนาจอเดมิ 
- Split View Horizontally and Add คือ การเพิ่มหนาจอของ Data View ออกทางดานลาง

ของหนาจอเดมิ 
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- Maximize this View คือ การสั่งใหแสดงหนาจอของ Trand Plot โชวเตม็หนาของ

โปรแกรม 

- Restore View คือ การสั่งใหหนาจอที่ขยายเต็มโปรแกรมกลับสูรูปแบบเดิม 
 

Database 
หมายถึง ที่เกบ็ขอมูลทั้งหมด เชน Spectral Data, ขอมูล ID ของ Standard และ ID Sample สามารถนําเอา
ขอมูลนี้จัดเก็บ แลวนําไปใชรวมกับโปรแกรม Microsoft Access ได โดยตองจดัเก็บในรูปแบบของ
นามสกุล (.mdb) หรือใชรวมกับโปรแกรม SQL  
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Toolbar Buttons 

 
หมายถึง ปุมทีช่วยใหเราสามารถใชคําส่ังที่มีการเรียกใชบอยๆ แสดงไวที่หนาจอ ทําใหเราใชงาน
โปรแกรม EasyMatch QC ไดงาย 
 
 โดยปุมปกติมดีังนี ้
 

ปุมสําหรับเปด Job ใหม 
 
  ปุมสําหรับเปด Job ที่เคยสรางไวแลว      
 
  ปุมสําหรับสั่งพิมพ 
 
  ปุมสําหรับสั่งดูขอมูลกอนการพิมพ 
 
  ปุม Save Job 
 
  ปุมสําหับอานคา Standard 
 
  ปุมสําหรับอานคา Sample 
 
  ปุมสําหรับสั่งใหทําการ Standardize 
 
  ปุมสําหรับสั่งใหปดโปรแกรม 
 
  ปุมสําหรับดูขอมูลชวยงาน 
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    Part III . Lessons 
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LESSONS 1: Setting Up a Job Template 
บทนี้จะเปนการกําหนดและใชคาJob Template 

 
เงื่อนไข 
     - Job Tree 
     - กําหนด ColorScale CIELAB, DE*, และ Y brigness โดยใชแหลงแสง D65/10 และ C/2  
     - กําหนดวนัที่และOprator กําหนดการวัดแบบเฉลี่ย 
     - โชว  ColorPlot ที่ D65/10 
     - โชว Trand Plot สําหรับ DL*,Da*,Db* และ DE* โดยใช D65/10 
เร่ิมตนการ Set  

1.  ที่ Menu File เปด New Job ทําการสรางชื่อ 
2.  ที่ Menu View เลือก Job Tree ใหทํางาน ( ถายังไมไดส่ัง) 
3.  ทําการสรางหนาตาง Color Data Table โดย Click ขวา ที่ กรอบของ Job Tree เลือก Change 

View เลือก Color Data Table (ถามีหนาตางนี้อยูแลวขอนี้ไมตองทํา) 
4.  Click ขวาที่กรอบของ Color Data Table เลือก Configure หนาจอจะโชว 
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5.  ทําการเลือกขอมูลตามขอกําหนด เชน  

Scales    CIELAB 
Illuminant/Observers   D65/10 then C/2 
Differences    DE* 
Indices    Y brightness 

6.  ในสวนกรอบดานขวา เลือก 
Additional Information   Date, Operator ID, and Average 
Data Orientation   Row Major 
Digits Beyond Default  0 
Font Size    8 
Auto Size Cells   Checked 
 
 

 
 
 
 
 
 
 
 
 
 
 

7.  กด OK เพื่อทํางานตอ 
8.  Click ขวาที่กรอบของ Color Data Table เลือก Split View Vertically and Add แลวเลือก 

Color Plot จะมีหนาตางของ Color Plot อยูทางดานขวาของหนาตาง Data Color Table ( ถา
มีหนาตางนี้อยูแลวไมตองทํา) 
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9.  Click ขวาที่หนาตาง Color Plot เลือก Configure หนาจอจะโชว 

 
 
 
 
 
 

 
10. ทําการเลือก 

Illuminant    D65/10 
Display Mode   Relative 
Scale and Tolerance   CIELAB, Rectangular 
Automatic Range   Checked 
Hue and Chroma   Unchecked 

 
 
 
 
 
 
 
 

11. Click OK. 
12. Click ขวาที่กรอบของ Color Plot เลือก Show Background และShow Legend. 
13. Click ขวาที่ Color Plot เลือก Split View Horizontally and Add เลือก Trand Plot ( ถามี
หนาตางนี้อยูไมตองทํา ) 
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14. Click ขวาที่กรอบของ Trand Plot เลือก Configure หนาจอจะขึ้น 

 
 
 
 
 
 
 
 
 

15. ทําการเลือก 
Quick set with Scale   Unchecked 
Trace 1    Difference, DL* 
Trace 2    Difference, Da* 
Trace 3    Difference, Db* 
Trace 4    Difference, DE* 
Illuminant/Observer   D65/10 
Display    Columns 
Measurements per display  25 
Statistics    Both items unchecked 
Auto Range    Checked 
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16. กด OK. 
17. เขา เมนู Option เลือก Default Tolerances 

 
 
 
 
 
 
 
18. ในสวน Scales เลือก CIELAB เลือก Illuminant/Observer เปน D65/10 
19. กําหนดคา Tolerance เปน ±0.5 ในสวนของ L*a*b* 

 
 

 
 
 
 
 
 

20. กด OK. 
21. Click ขวาที่กรอบของ Trand Plot เลือก Limits 
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22. ในหนาจอของ Trand Plot Limits ใหทําการเลือก 

Trace 1 Range   Do not change, since we selected Auto Range in 
Step 16 
Trace 2 Range   Do not change, since we selected Auto Range in 
Step 16 
Trace 3 Range   Do not change, since we selected Auto Range in 
Step 16 
Trace 4 Range   Do not change, since we selected Auto Range in 
Step 16 
Trace 4 ControlLimit  2 standard deviations 

 
 
 
 
 
 
 
 
 

 
23. กด OK. 
24. ถามีหนาตางอืน่อยู นอกเหนอืจากที่สราง เลือก Delete View 
25. เขา เมนู File เลือก Save Job Template ตั้งชื่อ Lesson 1 
26. ปรับคากรอบของหนาตางใหดูสวยงาม โดยใช Mouse เลือกตรงเสนกรอบ กด Mouse 
คางไว  จะสามารถยืด-ขยายกรอบได 

27. เขา เมนู Option เลือก Application Preferrance เขา Tab ของ Startup Default เลือก 
Lesson 1 เปน Default Template กด OK. 
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28. รูปแบบ Template ที่สราง 
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Lesson 2: Standardize and Confirming Standardize Using the White Tile 
บทนี้จะเปนการเรียนรูการทํา Standardize และการวัดคาแผน White Tile โดยจะกลาวทั้งในสวนของ 
Reflectance และ Transmittance 

1. เปด  New Job 
2. เขา เมนู Sensor เลือก Set Mode ( Mode Type เปน Rsin, Rsex) 

หมายเหตุ ถาใชเครื่องรุน ColorFlex หรือ MiniScan มีการทํางานแค Mode เดียว  

 
 
 
 
 
 

 
3. Highlight เลือก Mode ที่จะใชงาน ตรวจดู Parameter ใหตรงกับการใชงาน ถายังไมเคยสราง

ใหใชปุม Add Mode สรางขึ้นมาใหม 
4. เลือก Click Standardize ถาเครื่องเปนแบบ Diffuse (Sphere) โปรแกรมจะถามหา Light Trap 

แตถาเครื่องเปนแบบ 45/0 โปรแกรมจะถามหา Black Glass 
 

 
 
 
 

 
5. วาง Black Glass หรือ Light Trap ปด Port ในสวนของ Reflactance กด Next 
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6. โปรแกรมจะทาํการอานคาของ Black Glass หรือ Light Trap แลว Set เปน Zero เมื่อจบ
โปรแกรมจะขึน้หนาจอ 

 
 
 

 
 

7. ใหวาง แผน White Tile ปด Port ในสวนของ Reflectance กด Next 
8. โปรแกรมจะทาํการอานคาของ  White Tile แลวSet เปนคาTop Scale จากนั้นโปรแกรมตอบ

การทํางานเสร็จสิ้น 
 

 
 
 

 
 
9. Click Finish เพื่อเสร็จสิ้นการทํา Standardize แลวกด OK ที่หนาจอ Mode  เราจะเหน็ขอมูล

สถานะของ Standardize ที่มุมขวาดานลางของโปรแกรม (Status bar) 
10. ทําการตรวจสอบการทํา Standardize โดยทําการวัดคาแผนขาว (White Tile)โดยในหนาตาง 

Color Data Table ตั้งคา Scale XYZ และใช D65/10 
11. ทําการวัดคา Sample White Tile โดย Click Read Sample ที่ Toolbar 
12. ตั้งชื่อ Sample ID เปน White Tile แลวทําการอาน Click Read 
13. เมื่อเครื่องทําการอานคาแลวจะโชวคาในหนาตาง Color Data Table 
14. นําเอา White Tile ออกจาก Port วัดเทียบคาของ White Tile กับคาที่ไดจากการวัด คาที่ไดไม

ควรตางกันเกนิ (0.1 Unit ใน LabScan XE, 0.4  Unit ในเครื่องรุน ColorFlex และ MiniScan 
XE +) ถาตางกันเกนิ ใหทําการ Standardize ใหมโดยตองทําความสะอาด Black Glass, Light 
Trap และ White Tile กอน 
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Transmittance 
1. เปด New Job 
2. เขา เมนู Sensor เลือก Set Mode ( Mode type เปน TTRAN, RTRAN ) 

 
 
 
 
 
 
 
 
3. Highlight เลือก Mode ที่จะใชงาน ตรวจด ูParameter ใหตรงกับการใชงาน ถายังไมเคยสราง

ใหใชปุม Add Mode สรางขึ้นมาใหม 
4. เลือก Click Standardize 

- Ttran ใหวาง แผน Black Card ที่ดาน Sphere โดยเปดฝา Slide ตรงกลางเครื่อง ใหวาง 
Black Card ปดรูรับแสงดาน Sphere (ดานขวา)ใหสนิท เล่ือนฝา Slide ปดใหสนิทกด 
Next 

- Rtran ใหวางแผน Black Card ที่ดาน Len โดยเปดฝา Slide ตรงกลางเครื่อง ใหวาง 
Black Card ปดรูรับแสงดาน Len(ดานซาย)ใหสนิท เล่ือนฝา Slide ปด แลวกด Next 

 
 
 
 
 

 
 

5. โปรแกรมจะทาํการอานคา Black Card เมื่ออานแลวโปรแกรมจะใหนํา Black Card ออก 
แลวโปรแกรมจะใหวาง Blank Cell ( ถาไมมีไมตองใช) ปดฝาแลวกด Next 
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6. เมื่ออานเสร็จโปรแกรมจะใหนํา White Tile มาปด Port ที่ดาน Reflectance ใหกด Next 

 
 
 
 
 
 

 
7. โปรแกรมจะทาํการอานคา White Tile จากนั้นโปรแกรมจะโชว 
 

 
 
 
 

 
 

8. Click Finish เมื่อเสร็จสิ้นการทํา Standardize แลวกด OK ที่หนาจอ Mode จะเหน็ขอมลู
สถานะของ Standardize ที่มุมขวา ดานลางของโปรแกรม ( Status Bar ) 

9. ทําการวัดตวัอยางแบบ Transmittance ได 
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Lesson 3: Checking the Green Tile 
เปนการตรวจสอบการทํางานของเครื่องโดยทําการวัดเทียบกับแผนสเีขียว 
( ไมสามารถใชไดในเครื่องรุน ColorQuest XT, MiniScan XE+) 
 

1.  เขา เมนู File เลือก New Job ทําการสรางชื่อเปน “ Green Tile Check” 
2. ทําการตั้งคาในหนาตาง Color Data Table โดยดูรูปแบบการตั้งใน LESSON 1 

  
 
 
 
 
 
 
 
 
 
 
3. Click OK 
4. ทําการ Set คาในหนาตาง Trend Plot โดยเขาที่ Configure ของ Trand Plot 
 Quick set with Scale  Unchecked 
 Trace 1    Difference, DX 
 Trace 2    Difference, DY 
 Trace 3    Difference, DZ 
 Trace 4    None 
 Illuminant/Observer  D65/10 
 Measurement per Display 25 
 Display    Line,Point 
 Statistics   Standard Deviation Checked 
 Auto Range   Checked 
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5. Click OK. 
6. Click ขวาที่ Job Tree เลือก Enter Standard Data 

 
 
 
 
 
 

 
7. ในหนาโปรแกรม ใหเลือกในสวนของ Type of data being entered เปน Colorimetric เลือก 

Scale เปน XYZ เลือก Illuminant/Observer เปน D65/10 สวนคา Value ให Keyเขาไปเอง
โดยดูจากคาทีไ่ดรับมาจาก HunterLab ในสวนของแผน Green Tile 
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8. Click OK. 
9. ใสช่ือ Standard ID เปน “ Values Read at Factory “ กด OK 
10. Click ขวาที่ Value Read at Factory ใน Job Tree เลือก Properties 
11. Click Tolerances เลือก Click Difference 
12. ตั้งคา DX ที่ D65/10 โดยรุน ColorFlex และ ColorQuest XE ตั้งที่ ± 0.3 สวนรุน LabScan 

XE, UltraScan XE, UltraScan Pro ตั้งที่ ± 0.15 
13. ตั้งคา DY ที่ D65/10 โดยรุน ColorFlex และ ColorQuest XE ตั้งที่ ± 0.3 สวนรุน LabScan 

XE, UltraScan XE, UltraScan Pro ตั้งที่ ± 0.15 
14. ตั้งคา DZ ที่ D65/10 โดยรุน ColorFlex และ ColorQuest XE ตั้งที่ ± 0.3 สวนรุน LabScan 

XE, UltraScan XE, UltraScan Pro ตั้งที่ ± 0.15 

 
 
 
 
 
 
 
 
 
15. Click OK 
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16. ทําการ Standardize ใน แบบ Reflectance โดย 

- ตั้งคา Mode  Rsin สําหรับเครื่องรุน ColorQuest XE, UltraScan XE, UltraScan Pro ใช 
Port 1.00 นิ้ว และไมตองตั้งคา UV ( UV เปน Nominal ) 

- ใช Port 1.25 นิ้ว สําหรับ ColorFlex 
- ใช Port 1.75 นิ้ว สําหรับ LabScan XE 

17. ทําการวัดคาของ แผนGreen Tile 
18. เปรียบเทียบคาที่ไดจากการวัด 
19. ทําการ Re-Save Green Tile Check Job 
20. ทําการวัดคาเทยีบแผน Green Tile  ทุกๆ 16-19 Week เพื่อเปนการทดสอบประสิทธิ์ภาพการ

ทํางานของเครื่อง 
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Lesson 4: Querying the Database to Recall or Delete Data 
เปนการสั่งใหโปรแกรมทําการเรียกขอมูลจากDatabase หรือลบขอมูลใน Database 

1. เขาเมนู File เลือก Delete Measurement From Database จะเขาหนาจอ 

 
 
 
 
 
 
2. ถาตองการตรวจสอบขอมูลตามวันที่ ใหเลือก Click ที่ More จะเขาหนาจอ 

 
 
 
 
 
 
 
 
 
 
 
 
3. ทําการเลือกวาจะทําการลบขอมูลใน Sample หรือ Standard  
4. ทําการเลือกในชองของ Include data in the search ใหทํางาน 
5. Click ชวงของวันที่เร่ิมตนที่เราตองการจะดึงขอมูลออกมาด ู กอนจะทําการลบขอมูล 
6. Click ชวงของวันที่สุดทายที่เราตองการจะดึงขอมูล (เปนการกําหนดกรอบขอมูล) 
7. ไมตองกําหนดกรอบของเวลา 
8. สามารถกําหนด Parameter ที่จะทําใหคนหาเพิ่มเติมได 
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9. สามารถทําการจัดเก็บรูปแบบในการคนหาได ในสวนของ Query ID โดยตั้งชื่อและทําการ 

Save  

 
 
 
 
 
 
 
 
 
 
 
 
10. เมื่อ Click OK. โปรแกรมจะทําการคนหาขอมูลตาม Parameter ที่ไดกําหนดไว  
11. สามารถเลือกขอมูลเพื่อลบได โดยกาเรือ่งหมายถูกทีข่อมูลที่ตองการ 

 
 
 
 
 
 
 
 
 
 
12. โปรแกรมจะถามวาตองการลบขอมูลจริงหรือไม 
13. ถาตอบ Yes โปรแกรมจะทําการลบขอมูลที่เลือกไว 
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Lesson 5: Sharing Data and Setups with a ColorFlex or MiniScan XE Plus 
เปนการนําขอมูลจากเครื่อง ColorFlex และ MiniScan XE Plus ที่เก็บไวในตวัเครื่องมาใชในโปรแกรม 
EasyMatch QC. 
รูปแบบการใชงาน 

1. ตอเครื่อง ColorFlex และ MiniScan XE Plus ใหเรียบรอย ทําการเรียกโปรแกรม EasyMatch 
QC  

2. ทําการสราง Job และกําหนดรูปแบบของ Configure ที่ตองการ 
3. เขา เมนู Sensors เลือก Import Logged Reads โปรแกรมจะเขาหนาจอ 

 
 
 
 
 
 
 
 

 
4. Click Retrieve Data โปรแกรมจะทําการดึงขอมูลมาโชวที่หนาโปรแกรม 
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5. ใหทําการเลือกขอมูลมาใชงาน โดยใช Mouse  Highlight หรือ ใช Mouse รวมกับปุม Ctrl เพื่อ

ทําการเลือกขอมูล เปนชวงๆ 
 
 
 

 
 
 
 
 
 
 

6. Click Copy to Job โปรแกรมจะทําการดึงขอมูลที่ไดทําการ Highlight มาเขาในหนาจอสําหรับ
ทํางาน 

  
 
 
 
 
 
 
 
 
 
 
 
 

7. สามารถทําการ คัดลอกขอมูลทั้งหมดมาใสใน Database ได โดยทําการเลือก Select All 
โปรแกรมจะทาํการ Highlight ขอมูลทั้งหมด 
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8. Click Copy to Database โปรแกรมจะทําการนําขอมูลจัดเก็บใน Database 

 
 
 
 
 
 
 
 
 
 

ถาตองทําการปรับปรุงคา SETUP  NUMBER ท่ีอยูในเครื่องวัดสีก็สามารถทําไดโดย 
1. เขา เมนู Sensors เลือก Configue Setups โปรแกรมจะโชวหนาจอ 
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2. ทําการเลือกSet Number ที่ตองการจะเปลี่ยน 

 
 
 
 
 
 
 
 

 
 
 
3. กดปุม Retrive โปรแกรมจะดึงคาเกาของSetup  Number ที่เลือกจากเครือ่งวัดสีมาโชวที่

หนาจอ 
4. ทําการปรับเปลี่ยนคาใหมตามที่ตองการ 

 

 
 
 
 
 
 
 
 
 
 

5. เมื่อแกไขเรยีบรอยใหกดปุม Update Sensor เพื่อสงคาที่แกไขกลับไปใหตัวเครื่องวัดสี 
6. Click OK. เมื่อตองการออกจากการ Setup 
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Lesson 6: Using the Autolerancing Feature 
CMC autoleranceing 
วิธีใชงาน 

1. เปด New JOB และSet config ใน Color Data Table แลวตั้งรูปแบบการใชงานดงันี้ 
Scale    CIELAB 
Illuminant/Observer  D65/10 
Difference   DE CMC 
Indices    None 
Additional Information  Pass/Fail and Tolerance Checked 
Data Orientation  Row Major 
Digits Beyond Default  0 
Font Size   8 
Auto Size Cell   Checked 
 
 
 
 
 
 
 
 
 
 
 
 

 
2. ในสวนของ Color Plot ใหปรับ Configure ดังนี ้

Illuminant/Observer  D65/10 
Display Mode   Relative 
Scale and Tolerance  CIELAB, Elliptical 
Automatic Range  Checked 
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Hue and Chroma  Unchecked 
 
 
 
 
 
 
 
 
 

 
3. ทําการ STANDARDIZE เคร่ือง  ทําการอานคา Standard โดยใสชื่อเปน “ Standard” 
4. Click ขวาคา Standard ใน Job Tree เลือก Properties จาก Menu 
5. ใน Properties  ของ Standard  ใหเลือก Tolerance 
6. ในหนาจอของ Tolerance ใหเลือก Autoleranceing 
 
 
 
 
 
 
 
 
 
 
 
7. ใหเลือก Scale เปน CIELAB การเลือก Scale ตองให Match กับหนาจอของ Color Data Table  

และ Color Plot เลือก Illuminant/Observer เปน D65/10 ซ่ึงตอง Match กับหนาจอของ Color 
Data Table และ Color Plot 

8. ในชอง l:c ratio ใหใส 2:1 ซ่ึงคานี้เปนคามาตราฐานของสูตร CMC ในสวนของอตุสาหกรรม 
Textile แตในอุตสาหกรรมอื่นอาจมีคาตางกันได 
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9. ใสคา 1 ในชองของ Commercial Factor ซ่ึงคานี้เปนคามาตราฐาน 
10. ใสคา 0.75 ในชองของ Auto tolerance Correction Factor 
 
 
 
 
 
 
 
 
 
 
 
 
11. Click ปุม Calculate คา Tolerance ของ L*a*b*, D65/10  สําหรับคา Standard จะทําการสราง

คา อัตโนมตัิ ของ Tolerance และใสในสวนของ Tolerance Boxed 
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12. Click OK 2 คร้ัง จะเห็นคาของ Tolerance Show ฮยูในหนาของ Color Data Table และ Color 

Plot 
 
 
 
 
 
 
 
 
13. ทําการ Save Job และ Save Standard to Database ในสวนของ Automatically-generated จะ 

Save ตาม 
14. เม่ืออานคา Sample โปรแกรมจะทําการเปรียบเทียบกับคา Standard 
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Lesson 7: Using Custom Data and Formula Fields 
เปนการสรางที่ใสขอมูลเพิ่มเติมและ สรางสูตรขึ้นมาใชเอง 
วิธีใชงาน 

1. เปด Job แลวเขาท่ี  Color Data Table 
2. ตั้งคา Configure ของ Color Data Table 

Scale    CIELAB 
Illuminan/Observer  C/2 
Difference   None 
Indices    None 
Data Orientation  None 
Digits Beyond Default  2 
Font Size   8 
Auto Size Cells   Checked 

3. Click ท่ีชอง Insert Custom Field ปรับคาของ Configure ใน  Box 
 
 
 
 
 

 
4. ใหเลือก Data Field  เลือก New และใสคา “ ph ” ในชองของ Label Box 
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5. Click OK 2 คร้ัง ใน Configure ของ Color Data Table คาของ  Field “ ph “ จะปรากฎใน

หนาจอของ Color Data Table 
 
 
 
 
 
 
 
 
 
 
6. ใหทําการอานหรือ เรียกขอมูลของ Sample และ Standard จาก Job มาแสดง 
7. เลือกขอมูลหนึ่งจาก Job Tree ทําการ Click  ขวาท่ีขอมูลนั้นจะมี Menu แสดงดานลางวา  

Enter ph Data ใหเลือก Enter ph Data 
 
 
 
 

 
8. ใสคาของขอมูลลงไป 
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9. Click OK ขอมูลจะถูกนํามาโชวใน Color Data Table 
 
 
 
 
 
 
 
 
 
10. ใสคาของขอมูลในตัวอยางตอไป 
11. Click ขวาใน Color Data Table เลือก Color Data Table Configure 
12. Click Insert Custom Field หนาจอจะขึ้น Configure Custom Field 
13. เลือก Formula Field ใสชื่อ “ ph Lightness “ ลงใน Label Box 
 
 
 
 
 
 
 
14. Click OK  Configure ของ Formula Field จะโชว 
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15. Formula Field ท่ีไดจะอยูใน Column E ใหใสสูตรที่ตองการลงใน Formula Boxเชน =A#+D# 
 
 
 
 
 
 
 
 
 
 
16. Click Set Formula แลวกด OK 2 คร้ัง  โปรแกรมจะนําสูตรท่ีไดกําหนดมาใสในชอง “ ph 

Lightness “ ในสวนของ Standard และ Sample 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 



   Color Global Co.,Ltd.  

69

Lesson 8: Setting Up a Print Job  
เปนการกําหนดขอบเขตและรูปแบบของการพิมพ 
การใชงาน 

1. กําหนด Defult Printer ใน Windows 
2. กําหนด Page Size ของ Printer 
3. ใน EasyMatch QC เขา Menu File เลือก  Header/Footer Setup 

 
 
 
 
 
 
 
 
 
 
 
 

4. ใน Header Information Box ใหทําการเปลี่ยน Text เปน “ Lesson 8 “ ในสวน Footer 
Information ใหเปล่ียนเปน %n ( Page Number) 
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5. Click OK จะได New Header และ  New Footer 
6. เขา  Menu File เลือก Page Setup ใหปรับ Page Margins ตามตองการ กด OK 

 
 
 
 
 
 
 
 

7. เขา Menu File  เลือก Print Job Setup ใน Print Job Setup สามารถนําเอาหนาตางที่มีอยู
ท้ังหมดของโปรแกรมมาใชในการสั่งพิมพได และนําเอา Header และ Footer มาพิมพได  ( 
หนาตางมี Color Data Table, Color Plot, Spectral Plot, Spectral Data Table, EZ View, 
Trand Plot, Color Render ) การเลือกหนาตางมาสัง่พมิพ ขึ้นอยูกับหนา Template วา ไดเลือก
หนาตางอะไรมาโชวท่ี Job Template บาง 
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8. การเลือกวาตองการพิพมหนาจอไหน จากรูปชอง Avariable Items คือหนาตางที่สามารถนํามา

พิมพได ตรงกลางหมายถงึรปูแบบขนาดของกระดาษ  ดานซาย Selected Items คือหนาตางที่
เราเลือกจะพิมพ ใหทําการ Highlight ท่ีหนาตางที่ตองการดาน Avaliable Items เลือก Add จะมี
ชื่อหนาตางยายมาในสวนของ Selected Items 

 
 
 
 
 
 
 
 
 
 
 

9. กําหนดกรอบของหนาตางในการพิมพ ให Highlight หนาตางที่อยูทาง Selected Items 
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10. ใช Mouse โดยเลื่อย Mouse มาท่ีกรอบของกระดาษ Click ซายคางไว แลวเล่ือน Mouse เพื่อ

กําหนดขอบเขตของหนาตาง แลวปลอยจะไดกรอบของหนาตางที่เราตองการ 
 
 
 
 
 
 
 
 
 

11. ใหทํากับหนาตางอืน่ๆเหมือนกันจนกรอบของกระดาษเปนท่ีพอใจ 
 
 
 
 
 
 
 
 
 
 

12. ถาตองการทําหนากระดาษตอไป ทําไดโดย Add Page แลวสามารถ Set หนาตางไดอีก 
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13. เม่ือทําเสร็จแลวเลือก  Click OK 
14. ถาตองการดูรูปแบบกอนการสั่งพิมพ ใหเขา Menu File แลวเลือก Print-Job Preview 

 

 
 
 
 
 
 
 
 
 
   Page 1       Page 2 
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Part IV.  Software Menu 
Commands 
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            บทที่  3 
          The File Menu 
 
 เปนเมนูสําหรบัทําการ Open , Save , and Close jobs, เก็บขอมูล, ส่ังพิมพงาน, สงE-mail, Exit 
Program 

 

File/New Job 
หมายถึง การสรางชื่อและที่เก็บขอมูลใหม  

 

File/Open Job 
หมายถึง การเปดเอาที่เก็บขอมูลที่ไดสรางไวแลวมาใชงาน 

 
 
 
 
 
 
 
 

File/Open Job Template 
หมายถึง การเรียกเปดรูปแบบโครงสรางของโปรแกรมที่ไดสรางไวมาใชงาน 
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File/Recall Measurement From Database 
หมายถึง การคนหาขอมูลใน Databaseแลวเรียกมาใชงาน โดยสามารถกําหนด Parameter เพื่อใหคนหา
ขอมูลที่ตองการได 

 
  
 
 
 
และสามารถเพิ่มขอมูลในการคนหาไดโดยการกด More 

 
 
 
 
 
 
 
 
 
 
 
ถาตองการเอาขอมูลไหนมาใชก็ใหกาเครือ่งหมายที่ตวันั้น 
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File/Delete Measurement From Database 
หมายถึง การลบขอมูลที่อยูใน Database  

 
 
 
 
 
 
และสามารถเพิ่มขอมูลในการคนหาไดโดยการกด More 
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ถาตองการลบขอมูลไหนก็ใหกาเครื่องหมายที่ตัวนั้น 

 
 
 
 
 
 
 
 
 
 
 
 
 

File/Close Job 
หมายถึง การสั่งให Job ที่เปดอยูปดตวัลง  

 

File/Save Job 
หมายถึง การสั่งใหโปรแกรมทําการจัดเกบ็ขอมูลลงใน Job ปจจุบนั 

 

File/Save Job As 
หมายถึง การสั่งใหโปรแกรมทําการจัดเกบ็ขอมูลลงใน Job ที่เราทําการสรางชื่อใหใหม 
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File/Save Job Template 
หมายถึง การสั่งใหโปรแกรมทําการจัดเกบ็รูปแบบของโครงสรางหนาตาง โดยใชช่ือFileเดิม 

 

File/Save Job Template As 
หมายถึง การสั่งใหโปรแกรมทําการจัดเกบ็รูปแบบของโครงสรางหนาตาง โดยใชช่ือFileที่สรางขึ้นใหม 

 
 
 
 
 

File/Apply Template to Job 
หมายถึง การสั่งใหนํารูปแบบ Template ที่เรียกมา  มากาํหนดใชในปจจุบัน 

 

File/Save Measurement to Database 
หมายถึง การจดัเก็บขอมูลของ Standard และ Sample โดยการเลือก Highlight ที่ Job Tree เพื่อเก็บเขา 
Database 

 

File/eSignature (-ER Version Only) 
หมายถึง การกาํหนดลายเซ็นในการจดัเก็บขอมูล (เปน Option) 

 
 
 
 
 
 
 
 
 
 

 



   Color Global Co.,Ltd.  

80

File/Header//Footer Setup 
หมายถึง การกาํหนดขอความสําหรับ หัวกระดาษและ ทายกระดาษ เพือ่ใชในการพิมพ 

 
 
 
 
 
 
 
 
 

File/Print Job Setup 
หมายถึง การกาํหนดรูปแบบ ในการพิมพ  โดยสามารถกําหนดรูปแบบการพิมพไดเอง 
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File/Print Job Preview 
หมายถึง การสั่งใหโปรแกรมโชวรูปแบบของการสั่งพิมพ กอนที่จะทําการพิมพ 

 
 
 
 
 
 
 
 
 
 
 
 
 

File/Print Job  
หมายถึง การสั่งใหโปรแกรมพิมพงาน 

 
 

File/Printer Setup 
หมายถึง การเลือกเครื่องพิมพมาใชในการพิมพงาน 
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File/Page Setup 
หมายถึง การกาํหนดขอบเขตของขอความที่จะพิมพลงบนกระดาษ 

 
 
 
 
 
 
 

File/Export 
หมายถึง การสั่งใหโปรแกรมสงขอมูลไปใชรวมกับโปรแกรมอื่น 

 
• Export to PDF (-ER Version Only) 

สงขอมูลออกไปในรูปแบบของ File PDF (ใชเฉพาะกับ Version –ER) 
 

• QTX Format 
สงขอมูลออกไปในรูปแบบ Format QTX สามารถเปดดูขอมูลโดยใช Windows Notepad 
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• SLI-Taper 
สงขอมูลออกไปในรูปแบบ Format Dat สามารถเปดดูขอมูลโดยใช Windows Notepad 

 
 
 
 
 
 
 
 
 

File/E-Mail This Job 
หมายถึง การสั่งใหโปรแกรมสามารถจัดสงขอมูลไปทาง E-mail ได 

 
 
 
 
 
 
 
 
 
 
 

File/Time Synchronization (-ER Version Only) 
หมายถึง การตรวจสอบการใชงานของ Administrator เพื่อเช็คการเขาใชงานของ User (ใชเฉพาะกบั 
Version –ER ) 
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File/Database 
หมายถึง รูปแบบการในการชวยจดัเก็บขอมูล 

 
• Backup Database 

การสั่งใหโปรแกรมทําการจดัเก็บสํารองขอมูล 

 
 
 
 
 
 
 

• Import Databasebase 
 
 

การที่โปรแกรมสามารถนําขอมูลจากโปรแกรม Universal (โปรแกรม QC ของ HunterLab) มา
ใชรวมกนักับโปรแกรม EasyMatch QC 
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• Create New Database 
การกําหนดที่จดัเก็บ Database ใหม 

 
 
 
 
 
 
 
 
 
 

File/Log Off 
หมายถึง การยกเลิกผูใชปจจบุันออกจากการใชงานของโปรแกรม (ตองมีการกําหนด Login ) 

 
ถาตองการเขาใชโปรแกรมใหมตองใส User Name และ Password 
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File/Most Recently Opened Job 
หมายถึง การดกูารเปดเขาใชงานของ Job 4 คร้ังสุดทาย 

 

File/Exit 
หมายถึง การสั่งใหทําการปดโปรแกรม EasyMatch QC 
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                                       บทที่ 4 
            The Edit Menu 
 
 เปนเมนูที่ชวยในการเคลื่อนยายขอมูล 

 

Edit/Cut 
หมายถึง การสั่งใหโปรแกรมทําการตัดขอมูลที่ได Highlight เพื่อยายขอมูลไปไวในสวนอื่น (ตองใช
รวมกับ คําส่ัง Paste)  

 

Edit/Copy 
หมายถึง การสั่งใหโปรแกรมทําการคัดลอกขอมูลที่ได Highlight ไปใชรวมกับขอมลูสวนอื่น  
(ตองใชรวมกบั คําส่ัง Paste ) 

 

Edit/Paste 
หมายถึง การสั่งใหทําการวางขอมูลที่ไดทําการ Cut หรือ Copy วางลงตรงตําแหนงที่ตองการ 

 

Edit/Delete 
หมายถึง การสั่งใหทําการลบขอมูลที่ได Highlight 
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                                                                           บทที่ 5 
                                                    The View Menu 
 
 เปนเมนูที่ชวยเกี่ยวกับการโชวรูปแบบที่ Display 

 

View/Toolbar 
หมายถึง การเลือกใหโปรแกรมทําการโชวหรือไมโชว Toolbar ที่หนาจอ 

 
 

Toolbar is 
Displayed 

 
 
 
 
 
 
 
 

Toolbar is not 
Displayed 
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View/Status Bar 
หมายถึง การเลือกใหโปรแกรมทําการโชวหรือไมโชว คาสถานะของโปรแกรมที่หนาจอ 

 
 
 
 
 
 
 
 

Status bar is 
displayed 

 
 
 
 
 
 
 
 
 
 

Status bar is not 
Displayed 
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View/Job Tree 
หมายถึง การเลือกใหโปรแกรมทําการโชวหรือไมโชว สวนของ Job Tree ที่หนาจอ 

 
 
 
 

Job Tree is 
Displayed 

 
 
 
 
 
 
 
 
 
 

Job Tree is  not 
Displayed 

 
 
 
 
 
 
 

View/Audit Log (-ER Version Only) 
หมายถึง การเลือกดูขอมูลการใชงานของโปรแกรมแตละ User วาทําอะไรกับโปรแกรมบาง (ใชกบั
เฉพาะ Version –ER) 
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                                                              บทที่ 6  
               The Measurements Menu 
  
Measurement/Read Standard 
หมายถึง การสั่งใหโปรแกรมทําการวัดขอมูล แลวนํามาเปนคา Standard 

 
 
 
 

Measurement/Read Sample 
หมายถึง การสั่งใหโปรแกรมทําการวัดขอมูล แลวนํามาเปนคา Sample โดยอยูภายใตคาของ Standard ที่
กําหนด 

 
 
 
 
 
 

Measurement/Average  
หมายถึง การสั่งใหโปรแกรมทําการวัดขอมูลแบบเฉลี่ย โดยตองกําหนดรูปแบบการวัดคาเฉลี่ยในสวน
ของ Menu Option ( Average Method) กอน 
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เมื่ออยูในหนาตางนี้ตอง Clickที่ Read เพื่อใหทําการวดัคาตอไปจนจบการตั้งคาเฉลี่ยที่กําหนด 

 
 
 
 
 
 
 
 
 

Measurement/Time Read 
หมายถึง การสั่งใหโปรแกรมทําการวัดคาขอมูลตามเวลา  โดยตองกําหนดรูปแบบของการวัดในสวนของ 
Menu Option (Configure Time Read)  กอน 

 

Measurements/Automatic Standard Search 
หมายถึง การสั่งใหโปรแกรมทําการคนหาคา Standard แบบอัตโนนัติเมื่อทําการวัด ตองใชรวมกับ Menu 
Option ( Configure Automatic Standard Search ) 
 
 

Measurement/Average Selected to Measurement 
หมายถึง การสั่งใหโปรแกรมนําขอมูลที่อานไดมาทําการเฉลี่ย 
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Measurement/Average Selected to Standard 
หมายถึง การสั่งใหโปรแกรมนําขอมูลจากคาStandard มาเฉลี่ย แลวนํามาเปนคา Standard 

 
 
 

Measurement/Average Selected to New Standard 
หมายถึง การสั่งใหโปรแกรมทําการวัดขอมูลแบบเฉลี่ย แลวนํามาเปนคา Standard ตัวใหม 
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              บทที่ 7 
     The Sensors Menu 
 
 เปนเมนูที่เกี่ยวของกับการ Set คาการสั่งงานของเครื่องวดัสี ซ่ึงในโปรแกรมนี้เราจะเรียก
เครื่องวัดสีวา Sensors 

 

Sensors/Install//Configure 
หมายถึง สวนที่ใชสําหรับ Setup การทํางานของเครื่องวดัสี 

 
 
 
 
 
 
 
 
  
กด Add Sensor เพื่อเลือกเครื่องวัดสีใหม 

 
 
 
 
 
 
 
 
กด Sensors Type เลือก Model ใหตรงรุนที่ใชงาน กาเครื่องหมายถูกที ่Sensor ID เลือก Communication 
Port  ใหตรงกบัที่เราตอกับ Computer กด Next 
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• สําหรับเครื่อง ColorFlex และ MiniScan XE ใหตั้งชื่อ Mode Name และเลือก Area View ที่ใช 

และเลือก Standardize Now แลวกด Next 

• สําหรับเครื่อง ColorQuest XE, UltraScan XE และ UltraScan Pro ใหเลือกตั้งชื่อ Mode Name 
เลือก Area View เลือก Mode Type ถาเครื่องไมมี UV(ถาไมตองใช UV)เลือก Nominal (ถามี UV 
เลือกแลวแตจะใชงาน) และเลือก Standardize Now แลวกด Next 

เครื่องจะทําการ Standardize แผนดําและจะทําการ Standardize แผนขาว  

 

Sensors/Standardize  
หมายถึง การกาํหนดการปรับคาเริ่มตนของการวัด โดยตองกําหนด Mode ของการวัดกอนแลวคอยเลือก
ทํา Standardize  
        ขั้นแรกโปรแกรมจะทําการวัดคา แผนดํา 

 
 
 
 
 
       แลวจะทาํการอานคาแผนขาว 

 
 
 
 
       Click Finish เมื่อเร่ืองทํา Standardize ผาน 
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Sensors/Set Interval 
หมายถึง การกาํหนดระยะเวลาในการทํา Standardize ในครั้งตอไป ( ปกติไมควรตั้งไวเกนิกวา 8 ช่ัวโมง ) 
 

 

Sensors/Set Mode 
หมายถึง การกาํหนด Mode ในการใชงาน(ขึ้นอยูกับรูปแบบของการวัดตัวอยาง) เราสามารถSet Mode 
เพิ่มเติมได โดยขึ้นอยูกับFunction ของเครื่องวัดสีแตละ Model 

 

Sensors/UV Filter Calibration 
หมายถึง ใหเครื่องตั้งคา ในการทํางานแบบตองใช UV 

 
 

Sensors/Configure Multi Mode 
หมายถึง การกาํหนดรูปแบบของ Mode  หลายๆแบบในการใชงาน 
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Sensors/Import Logged Reads 
หมายถึง การนําดึงรูปแบบขอมูลจากภายนอกโปรแกรม เขามาใชรวมกันกับขอมูลในโปรแกรม (สําหรับ
เครื่องรุน ColorFlex และ MiniScan XE+ เทานั้น ) 

 
 
 
 
 
 
 
 
       Click Retrieve Data โปรแกรมจะทําการคัดลอกขอมูลการวัดทั้งหมดจากเครื่องวัดสี มาโชวที่หนาจอ 

 
 
 
 
 
 
 
 
 
    Sort By Log : ทําการเรียงขอมูลตาม Log Number ที่จดัเก็บ 
    Sort By Setup: ทําการเรียงขอมูลตาม Setup ที่จัดเก็บ 

    Select All: ทําการเลือกขอมูลทั้งหมด 
    Copy to Job: นําขอมูลที่เลือกไปโชวใน Job 
    Copy to Database: นําขอมูลที่เลือกไปจัดเก็บใน Database 
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Sensors/Configure Setups 
หมายถึง การกาํหนดคา Configure ใชสําหรบัเครื่องวัดสีรุน ColorFlex และ MiniScan XE+ 

 
 
 
 
 
 
 
 
 
    ปุม Retrieve หมายถึง ดึงขอมูลเครื่องวัดสีจากคาSetup Number ที่ตองการมาโชวที่
โปรแกรม 
    ปุม Update Sensor หมายถึง การถายขอมูลจากโปรแกรม เขาเครื่องวัดสี ตาม Setup 
Number 
    ปุม Retrieve  All หมายถึง การดึงขอมูลเครื่องวัดสีจากทุก Setup Number มาโชวที่
โปรแกรม 
    ปุม Update All หมายถีง การถายขอมูลจากโปรแกรมทุก Setup Number เขาเครื่องวัดสี 
    ปุม Read Standard หมายถึง การอานคา Standard มาไวในโปรแกรม ตาม Setup Number 
เพื่อเตรียม              
           Update  
    ปุม Recall Standard หมายถึง การดึงคา Standard จาก Database ที่เก็บไวใน Job มาไวใน
โปรแกรม 
             ตาม Setup Number เพื่อเตรียม Update 
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Sensors/Diagnostics 
หมายถึง การตรวจสอบการทาํงานของเครื่อง 

1. เมื่อเขาหนาจอมาโปรแกรมจะทําการตรวจ Eprom ของเครื่องวัดสีและแจงผลออกมาใหทราบ 
 
 
 
 
 
 

 
2. ปุม Refresh เปนการใหโปรแกรมทําการ Link กับ Eprom แลวโชวขอมูลอีกครั้ง 
3. ปุม Standardize เปนการทําการตรวจการ Standardize เครื่อง ซ่ึงบางรุนของเครื่องวดัสี สามารถ

ทําการ Standardize ไดหลายแบบ 
 
 
 
 
 
 
 
 
 

4. ปุม Read เปนการทําการอานคา ( ใหทําการอานคา White Tile ) แลวโชวเปน ขอมูล 
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5. ปุม HW Test เปนการสั่งใหเครื่องวัดสี ทําการตรวจสอบ Hardward ภายใน 
 
 
 
 
 
 
 
 
 
 
6. ปุม Signal Level เปนการทดสอบสัญญาณในการวดัคา (  ใหทําการวดัสัญญาณ แผน White Tile 

) 
 
 
 
 
 
 
 
 
 
7. ปุม Repeatability เปนการตรวจการวัดคาซ้ําๆ โปรแกรมจะทําการวัดคาซํ้าาจํานวน 20คร้ัง (วัด

คาแผน White Tile ) 
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8. ปุม Flash เปนการกําหนด รูปแบบการวดัใน  Port ขนาดตางๆ ( มีในเครื่องบางรุน ) 
 
 
 
 
 
 
 
 
 
9. ปุม Green Tile Test เปนการทดสอบการวัดคาของแผน Green Tile  
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                                                          บทที่ 8 
 The Options Menu 
      

Option/Application Preferences 
หมายถึง การกาํหนด Option ของการใชงานโปรแกรม EasyMatch QC. 

 
• Unit 
 การกําหนดรูปแบบของวันที ่

  
 
 
 
 

 
• Illuminant/Observer 
 การกําหนดแหลงแสงและมุมสังเกตการณ 
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• Language Setting  
 การกําหนดภาษาในการใชงาน 
 

 
 
 

 
 
 

• Start Defaults 
 การกําหนดรูปแบบของโครงสรางหนาตางที่เราไดสรางมา แลว Set มาเปนคาเริ่มตน 

 
 
 
 
 
 
 

- Login Required เปนการใหกาํหนด รหัสผานกอนการใชงานโปรแกรม 
- Deflult Job เปนการใหกําหนด รูปแบบของ Job ปกติกอนการใชงาน 
- Keep Sample Measurement Window Open เปนการใหเก็บคาการวดัตวัอยางเมื่อเปด 

Window 
- Lock sensor to Job เปนการ Lock  Job ใหใชกับ Sensor ตัวเคียว 
- Lock Standardization mode to Job เปนการ Lock  Job ใหใชกับ การ Standardize ที่ 

Mode ที่ Lock ไว 
- Retain IDs in Sample Measurement Window เปนการใหเก็บคา ID ในการวดั Sample 
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Options/Naming Conventions 
หมายถึง การกาํหนดรูปแบบของคา ID Standard, ID Sample, Product ID, Extra ID 

 
• Sample 

 
 
 
 
 
 
 
 
 Sample ID String Layout เปนการกําหนดชื่อของ ID สวนที่กรอกชื่อ Sample %n ตัวช่ือ 
Sample เราสามารถเปลี่ยนได สวน %n หมายถึง ให Run เร่ิมจากคาเริม่ตนของ Insert Number 
 
 

• Standard 

 
 
 
 
 
 

 
 Standard ID String Layout เปนการกําหนดชื่อของ ID สวนที่กรอกชื่อ Standard %n ตัวช่ือ 
Standard เราสามารถเปลี่ยนได สวน %n หมายถึง ให Run เร่ิมจากคาเริ่มตนของ Insert Number 
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• Product ID 

 
 
 
 
 
 
 
• Extra ID 
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Options/Default Tolerance 
หมายถึง การกาํหนดคาความตางของการวดั ในสวนของ Scale, Indices, Difference และ Shade 

• Scale 
 เปนการกําหนดคาความตางในสวนของ Scale (ตอง Setคา ScaleและIlluminant/Observer) 

 
 
 
 
 

 
• Indices 
 เปนการกําหนดคาความตางในสวนของ Indices (Scale เฉพาะ) ตอง Setคา Indexและ 
Illuminant/Observer 
 

 
 
 
 
 
• Differences 
 เปนการกําหนดคาความตางในสวนของคา Difference ตอง Set คา Difference และคา 
Illuminant/Observer 
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• Shade 
 เปนการกําหนดคาความตางในสวนของ Scale 555 
 
 
 
 
 
 
 
 

• Haze and Opacity 
 เปนการกําหนดคาความตางในสวนของ Scale  Haze และ Scale Opacity 
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Options/System Configuration 
หมายถึง การกาํหนดคาของการใชงาน User และ Admin และขอบเขตของการใชงานของโปรแกรม 

 

• User Manager 
 เปนการกําหนดคาการใชงานของ User ( ตองกําหนดโดย Admin ) 
 
 
 
 
 
 
 
 
 
  
Click ขวาที่ User เลือก New User ใสช่ือและรหัสผาน (ตั้งเอง) Click Create เพื่อสราง 
 
 
 
 
 

 
- Set Password 

ถามีช่ือ User อยูแลวหนาจอจะขึ้น 
 
 
 
 
 

 
ทําการปอน Password เกา และปอน Password ใหม 
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- Edit 

ทําการแกไข Full Name 
 
 
 
 

 
 

- Delete 
ทําการลบชื่อ User 

- Add to Group 
เปนการกําหนดกรุปในการใชงาน 
 
 
 
 
 
 
 
 
Click ขวาที่ Group เลือก New Group ทําการกรอกชื่อ Group ใหม แลวกด Add ถา
ตองการลบ Group เลือก Highlight Groupที่ตองการแลงเลือก Remove แตถาตองการ 
Set Parameter ของ Group ใหเลือก Set Privileges 
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• Data Storage 
 เปนการกําหนดลักษณะการเก็บขอมูลไปใชรวมกับโปรแกรมอื่นเชน Microsoft Access หรือ 
SQL และรวมถึงการสั่งใหโปรแกรมทําการ Backup ขอมูลตามที่อยูและระยะเวลาทีก่ําหนด 
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• Server Settings  (-ER Version Only) 
 เปนการกําหนดชื่อของ Server กอนการใชงาน ( มีเฉพาะ Version –ER) 

 
 
 
 
 

 

Options/Average Method 
หมายถึง การกาํหนดคําส่ังในการทํางานของการวัดคาเฉลีย่ 

 
 
 
 
 
 

 
 
 เปนการกําหนดคาในการทํางานในกรอบของการวัดคาเฉลี่ย เชน เวลาวดัคาเฉลี่ยตองโชว 
Scale แบบไหน, คา Illuminant/Observer อะไร ทําการวดัเฉลี่ยจํานวนกี่คร้ัง เปนตน เมื่อทําการ Set
คาเรียบรอยตองไปสั่งใหทําการวัดคาเฉลี่ย โดยตองไปClick ที่ Menu Measurment เลือก Average 
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Options/Read Method 
หมายถึง การเลือกรูปแบบของการอาน เชน Normal, Opacity , Haze และ Multiple Read Mode 

 
 
 
 
 
 
 
 
     สําหรับวัดตวัอยางทั่วๆ ไป 

 
 
 
 
 
 
 
 
 สําหรับวัดตวัอยางแบบ Reflectance ที่ตองการดูคาการทึบแสงหรือโปรงแสง 
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 สําหรับวัดตวัอยางแบบ Transmittance ที่ตองการดูคาความขุน 

 
 
 
 
 
 
 
 
 
 

Options/ASCII Export 
หมายถึง การกาํหนดรูปแบบของขอมูลและลักษณะของขอมูล ในการสงออกไปใชรวมกับโปรแกรม
ภายนอก 
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 ทําการเลือกขอมูลจากดานขวายายไปดานซาย เพื่อเปนการกําหนดรูปแบบของขอมูล กําหนด
ช่ือ File ในการสงขอมูลออกดวย 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Options/Adjust Scale Factors 
หมายถึง การกาํหนด การปรับตั้งคาเชน CMC, CIE94 และ CIELAB 2000 

 
 
 
 
 
 
 
 เมื่อเลือกคาแลว กด OK จะเปนการกําหนด Factor สําหรับใชงาน 
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 ถาตองการใชคา Factor ปกติกด Default Values ถาตองการเปลี่ยนใหกําหนดคาเอง 

 

Options/Configure Times Read 
หมายถึง การกาํหนดคําส่ังในการทํางานของ Time Read (ทําการอานคาตามระยะเวลา) 

 
 
 

 
 
 
 

Read Count Method 
 หมายถึง จํานวนครั้งในการทํางาน 
Read Interval 
 หมายถึง ระยะเวลาในการวัดแตละครั้งหางกันกีว่ินาท ี
เมื่อ Set คาเสร็จแลวถาตองการใหคําส่ังนี้ทาํงาน  ตองไปกําหนดใน Menu Measurement (Time 
Read) 
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Options/Configure Automatic Standard Search 
หมายถึง การกาํหนดรูปแบบในการคนหาคา Standard แบบ อัตดนมัติ ใชรวมกับ Menu  Measurment 
(Automatic Standard Search ) 

 
 
 
 
 
 
 
 

Options/Customize Toolbar 
หมายถึง การกาํหนดรูปแบบของ Toolbar ที่หนาจอ 

 
 
 
 
 
 
 
 
 
 
 
 

 

Options/Easy Group( Option ) 
หมายถึง การดขูอมูลในรูปแบบการแบงขอมูลเปน Group มักใชในกลุมอุตสาหกรรม Textile 
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      บทที่ 9 
     The Window Menu 
 

Windows/New Window 
หมายถึง การสรางหนาตางขึ้นมาใหมอีกหองหนึ่ง 

 
 
 
 
 
 
 
 
 

 
 

Windows/Cascade 
หมายถึง การจดัวางรูปแบบของหนาตางแบบซอนทับกัน 
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Windows/Tile 
หมายถึง การจดัวางรูปแบบของหนาตางแบบเรียงตอกัน 

 
 
 
 
 
 
 
 
 
 

 
 

Windows/List of Open Jobs 
หมายถึง การโชว รายการ Job ที่ทําการเปดใชอยู 
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      บทที่ 10 
      The Help Menu 
 
 เปนเมนูที่ชวยในการทํางาน เชน หาวิธีใชเมนูตางๆ, วิธีแกไข และ อ่ืนๆ 

 
 

Help/Help Topics 
หมายถึง การชวยในการคนหาขอความ และคําส่ังในการใชงาน และวิธีใชงานโปรแกรม 

 
 
 

Help/About 
หมายถึง การบอกคา Version ของ Software 

 
 
 
 
 
 
 
 
 
 

Help/HunterLab on the Web 
หมายถึง การชวยพาเขา Web Site ของ บริษัท HunterLab 

 
 
 

 



   Color Global Co.,Ltd.  

120

 
 

 


